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Release Highlights: W1461 SystemVue Core Platform
Phased Array/Beamforming (new product)
Many users reading these notes are interested in the new W1720 Phased Array Beamforming Kit, which is licensed as an add-on to the W1461
SystemVue core environment. Refer to the "add-on" W1720 Phased Array Beamforming Kit section below.

Dynamic Graphs
Dynamic graphing capability is implemented in the following models to display runtime data during simulation:
BeamMeasurement
BER_FER
ConstellationEnv and ConstellationCx
DigitalDemodEnv and DigitalDemodCx
Dynamic3D
EVM_Env and EVM_Cx
EyeDiagram
Sink
SpectrumAnalyzerEnv and SpectrumAnalyzerCx
Additionally, some add-on libraries provide additional measurement sinks with Dynamic Graph support, including
BeamMeasurement (W1720 Phased Array Beamforming Kit)
LTE and LTE-A EVM measurements (W1918 LTE-Advanced Library)
WLAN 802.11ac EVM measurements (W1917 WLAN library)
In general, you can turn on ContinuousMode in the models to enable dynamic display.
With DigitalDemodEnv, DigitalDemodCx, EVM_Env, and EVM_Cx, you now have the VSA-like dynamic graphs natively inside SystemVue. These models
use the same demodulation engine as in Keysight 89600 VSA software.
For phased array beamforming applications, Dynamic3D is a useful visualization tool to display beam pattern (generated by the BeamPattern model)

dynamically in spherical coordinate and also display antenna array locations in Cartesian coordinate.
Dynamic graph example workspaces can be located in \Examples\Tutorials/Plotting and Visualization under the SystemVue installation directory.

Filter Designer
S-Parameter models, SData and SData_M, are now supported in the Filter Designer.
A new "Save Graph Data" button is provided in the Filter Designer to save graph data to specified dataset.
In the Filter Designer, under "Custom - FIR - Frequency Response", if the Frequency specification contains negative frequency and if the
Complex data type is selected, a complex baseband filter ( CustomFIRCx ) will be designed and instantiated. This model will re-design the
filter based on the simulation sampling rate.

Algorithm Design Library
The SignalCombiner model now supports sample rate specification in rational format. This is very useful for some wireless standards where
sample rates could be infinite decimals but rational numbers. It also uses a better rational approximation algorithm for sample rate in decimal
representation.

Mapper/Demapper/Mapper_M/DigitalMod change for 8-PSK and 16-PSK constellations. Prior to the
SystemVue 2016.08 release the 8-PSK and 16-PSK constellations supported by Mapper , Demapper , Mapper_M a
nd DigitalMod had a starting point on the x-axis and the rest of the points were uniformly distributed around the
unit circle. Starting with the SystemVue 2016.08 release, these constellations do not have the starting point
on the x-axis but at angles of /8 and /16 respectively.
M8195 SignalDownloader has been enhanced to support 16G external memory, event marker and up to 4 channels
Updated GoldenGate FastCircuitEnvelope to support GoldenGate version 4.9.5.
Add SINAD_Cx and SINAD_Env for SINAD calculation

MATLAB Script
A new getinterpdata function can be used to extract the data of interest that can be used elsewhere in the
product. This is powerful multidimensional interpolator that can extract data from a multidimensional dataset.
For more information, please refer to getinterpdata.
graph.add_spherical_data( azimuth, elevation, magnitude ) convention has been changed to graph.add_spherical_data( phi, theta, magnitude )
convention, where phi = azimuth and theta = /2 - elevation.
getindepvalue function has been updated to support multiple independent variables. For more information, please refer to getindepvalue .

C++ Model Builder and Code Generation
SystemVue is now built with Microsoft Visual Studio 2013, as a result, C++ model builder libraries need to be compiled with Microsoft Visual
Studio 2013 to load into SystemVue. If you have existing C++ model builder libraries, compile them again using Microsoft Visual Studio 2013.
For Linux model building and code generation, you need to use gcc version 4.9.2 or later.
SystemVueModelBuilder::EnvelopeMatrix, SystemVueModelBuilder::EnvelopeMatrixCircularBuffer, and SystemVueModelBuilder::EnvelopeMatrix
CircularBufferBus are provided in \ModelBuilder\include\SystemVue\EnvelopeSignal.h for efficient and compact representation of an array of
envelope signals for phased array applications.

Other Platform Updates
Support Microsoft Windows 10 (64-bit), dropped support for all 32-bit operating systems.

Release Highlights: Add-on Libraries and Design Kits
W1713 Serdes Model Library
Add Relative Intensity Noise (RIN) to the VCSEL model
Add CTLE as pre-filter to the DFE_PAM model

W1714 IBIS AMI Model Generator
Add support for repeater generation
Add support for exporting PAM4 related reserved parameters
Add support for including custom C++ model libraries in the AMI Model Generation flow

W1717 Hardware Design Kit
HDL Code Generator now supports Xilinx Vivado project generation and new Xilinx FPGA families : Virtex 7, Zynq7000.
HIL flow supports Xilinx VC707 (in addition to ML-605)
HDL Tool Installation Directory settings have been updated in Global Options > Code Generation menu. It uses installation path instead of the full
path to the .exe file.
Enhancements to FPGA programming in the following Keysight instruments
M9703A wideband 8-channel digitizer, with (4) Virtex6 devices, in an AXIe chassis
M9703B wideband 8-channel digitizer, with (4) Virtex6
U5303A wideband 2-channel digitizer, with (1) Virtex6 in a PCIe card

devices, in an AXIe chassis

W1718 C++ Code Generator
support for Microsoft Visual Studio 2013

W1719 RF System Design Kit (Spectrasys)
Spectrasys Frequency Dependency Support
Spectrasys now supports frequency, dependent behavioral models. It enables vendor spreadsheet frequency, temperature, and bias dependent nonlinear
parameters such as 1dB compression, IP3, and IP2 to be conveniently used in the RF system simulation without the need to write custom equations.
Spectrasys will automatically interpolate the multi-dimensional data defined by a muli-tab spreadsheet or System MDIF file for the component such as a
power amplifier, for its correct characteristics at the frequency, temperature, and bias used in the simulation.
There are two modes of operation: 1) Normal or manual data entry or 2) Dataset or file based. When the simulator runs, spectrums are obviously created
at various frequencies. With this feature, the characteristics of this spectrum will be a function of the frequency dependent parameters.

See the Frequency Dependency section for additional information.

Normal Mode
In this mode, users can conveniently enter frequencies and parameter values at those frequencies.This entry method also supports mixed parameter fixed
and vector values. For example, if there is no frequency dependent data for a particular parameter the simulator will use the fixed value for all frequencies.
See the Supported Models for details on which models are supported for this mode.

Dataset / File Based Mode
When this mode is selected RF amplifier model data will automatically be extracted from a spreadsheet file (File > Import > Sys-Parameter Files > .csv,
Excel or File > Import > ADS Files > System MDIF File ) that will automatically be imported onto the workspace tree. Multiple independent variables like
temperature and power supply voltage can be supported in this mode when using an Excel file with data configured on multiple tabs.
See the Supported Models for details on which models are supported for this mode.

New Frequency Dependent RF Examples
ADS MDIF Import.wsg
Basic Mixer Frequency Response.wsg
Freq Dependent Stats Basics.wsg
Intermod Distortion vs Freq.wsg
Interpolated Data.wsg
L Band Transmitter.wsg
MiniCircuits Amp vs Temperature.wsg
Multidimensional Data 3D Graphs.wsg
Multisource PortZ vs Freq.wsg
Power Amplifier S2D.wsg

Import Keysight Sys-Parameter Files
Frequency dependent behavioral model data may be stored and imported via a Keysight Sys-Parameter files can be imported into a dataset. The SysParameters format is very flexible and can be implemented in a spreadsheet, csv, or MDIF files. M ultiple sheets are used to represent multidimensional
data.
For more information, see Importing Keysight Sys-Parameter Files.

Import ADS Files
ADS files such as GMDIF, MDIF, S2D, and P2D file import is supported. There are some limitations as SystemVue does not have the ADS models that
use these files directly. GMDIF and MDIF import support has been optimized around importing behavioral data for simulation so there are some aspects of
these files that may not be imported fully. Since SystemVue does not have a Data Access Component (DAC), you can import the data into a dataset.
Moreover, a new getinterpdata function can be used to extract the data of interest that can be used elsewhere in the product.
For more information, s ee ADS File Import .

Model Ambient Temperature Support
An ambient temperature parameter Ta has been added to all models. When this value is empty the analysis temperature is used during simulation
otherwise, it will use the value specified. When an analysis is run it will set the global temperature variable called TEMPERATURE. This value is then used
by models with empty values. For linear devices, the ambient temperature is used to calculate thermal noise. For all nonlinear devices, the ambient
temperature is used to calculated all nonlinear temperature dependent parameters including thermal noise.

New Non-Linear Digital Step Attenuator Model
A non-linear digital step attenuator part, model, and schematic symbol have been added.

New Limiter Model
A limiter part, model, and schematic symbol have been added. There is a new shipping example \Limiters\Limiter Basics.wsg showing the characteristics
of the limiter.

New Path Measurement
Path measurements now contain the complex input and output impedances:
ZIN
ZOUT

Reference Impedance Standardization

All models that need a reference impedance now use common parameters called Zref. In the past, some models used Zo or ParamZ.
The models that were updated are:
CIRCULATOR
DELAY
NonLin
NonLinHO
PHASE
SDATA_NL
SDATA_NL_HO
SDATA_NLI

Other Spectrasys Improvements
Add noise figure parameter to all SDATA_NL models

W1720 Phased Array Beamforming Kit (new product)
The new W1720 Phased Array Beamforming Kit provides new Spectrasys and Dataflow capability for dealing with multi-antenna architectures for phased
array/beamforming and high-order MIMO.

Dataflow support for Phased Arrays
Dataflow support for phased arrays comes in these main areas:
New datatype called "Time Envelope Matrix"
Array Configuration, Beam Synthesis and Beam Measurement
3D Visualizations
Examples: seen in the Examples\Beamforming.

New datatype: "Timed Envelope Matrix" Models
For phased array beamforming applications, a set of timed Envelope Matrix

RF behavioral models have been developed in this

release, including:
AddEnv_M
AddNDensity_M
Amplifier_M
Combiner_M
CustomFIR_M
CxToEnv_M
DelayEnv_M
Demodulator_M
EnvToCx_M
Mixer_M
Modulator_M
Oscillator_M
PhaseShifter_M
Splitter_M
SData_M
These models process multiple envelope signals in parallel and the envelope signals are stored inside envelope matrix data type. For N-antenna phased
array applications, you don't need to place N number of RF chains on schematic. Instead, you only need to place one RF chain using the envelope matrix
RF models and set the matrix dimension to N (or to RxC where N = R*C).
You can use the following models to convert between envelope matrix data type and traditional bus signal (multiport):
PackBus_M
UnpackBus_M
You can also use the following models for complex matrix related conversions:
CxToPolar_M
CxToRect_M
PolarToCx_M
RectToCx_M

Beamforming & Beam Measurement Models
For phased array beamforming applications, the following models are available to generate beamforming weights, to compute beam pattern, and to
measure beam pattern:
BeamformerWeights
BeamPattern

BeamMeasurement
For digital beamforming, you can use the following models together with BeamformerWeights:
DigitalBeamformerTx
DigitalBeamformerRx
The ArrayCoupling_M is also available to include mutual coupling effect in phased array antennas.
Most of the above envelope matrix models are designed to handle large size phased array systems (large size envelope matrices) and utilize multiple
threads for intra-model parallel processing. When using these models, you do not need to check the "Use Multithreaded Simulation" checkbox in the Data
Flow Analysis, which explores inter-model parallelism and may require large memory and compete for threads.

RF_Link Models for Phased Array Beamforming
You can use RF_Link_M model to link and parallelize a 1-in-1-out Spectrasys RF design to data flow design for envelope matrices.
You can use RF_Link_PhasedArray

model to link RF phased array design to data flow design for RF beamforming.

Examples
The data flow beamforming examples can be found in \Examples\Beamforming under SystemVue installation directory.

Spectrasys Support for Phased Arrays
If you own the W1719 RF System Design Kit, then the W1720 Phased Array Beamforming Kit also enables array-level abstraction for Spectrasys.
Support for RF system-level phased arrays consists of 3 new product areas:
A new Phased Array analysis controller (refer to Phased Array)
An "RF Phased Array" parts selector category, under "RF Design", which allow you draw 1 RF line-up, but simulate it as if it were an "N" element
array
Phased Array Antenna
Phased Array Attenuator
Phased Array Combiner / Splitter
Phased Array Phase Shifter
Phased Array RxPort/TxPort
Phased Array Time Delay
RF_LINK extensions (refer to RF_Link_PhasedArray), which allow you use the RF array in a Dataflow schematic, complete with dynamic control
of the gain/phase states.
Examples are available in

the "Examples\RF Architecture Design\Phased Array Analysis" folder

W1902 Digital Modem library
New model for Low Density Parity Check coding/decoding has been added from the 5G library

W1905 Radar Model library
Enhancements from the offcycle update release of the W1905 radar library (issued June 2016, for SystemVue 2015.01) have been included with
SystemVue 2016.08
The PDW file generation and instrument connection with Keysight N5193A UXG frequency-agile EW source are supported.
For the time of arrival, (TOA) of pulsed signals can be estimated with new model RADAR_TOA, pulse widths and PRIs can also be estimated
with this model.
To support dynamical simulation, several new models with the matrix data type interface are added.
The RADAR_EchoGeneration model is upgraded to support passive radar more easily.
RADAR_TCPSink and RADAR_UDPSink are updated and can export the data to 3rd application software. The related examples can be found in
the example directory
Note: the W1905 Radar library now includes the W1720 Phased Array Beamforming Kit, allowing deeper support for phased array development, and
applications of dynamic/custom beamforming.

W1906 5G library
New Flexible OFDM MIMO source and receiver
Support flexible OFDM structure consistent with FlexOFDM source
Support 8x8 MIMO configuration
Support MIMO precoding
Support channel estimation using pilots or preamble symbols
Support non-overlapping and overlapping pilot structure and corresponding channel estimation in the receiver
New F-OFDM SISO transmitter and receiver
Support flexible F-OFDM structure, such as FFT size, subcarrier spacing, pilot and data allocation
Support different shaping filter for F-OFDM

Support F-OFDM EVM measurement
Support BER measurement in AWGN
New UF-OFDM SISO transmitter and receiver
Support flexible UF-OFDM structure, such as FFT size, subcarrier spacing, pilot and data allocation
Support multiple subbands for each UF-OFDM source
Support different shaping filter for UF-OFDM
Support UF-OFDM EVM measurement
Support BER measurement in AWGN
New hybrid beamforming simulation
Support configurable and flexible hybrid beamforming architecture
Support Narrowband system and OFDM-based wideband system
Support ideal and practical beam training
Support Taylor window for beamforming
New 3D channel model
Support 3GPP channel model with user-defined scenario
Support NYU channel model, including mmwave UMi, Indoor, and user-defined scenario
Support up to 256x256 MIMO channel configuration
Support custom EMpro and HFSS antenna pattern import
New channel sounding simulation
Support reference signal generation for channel sounding measurement
Support channel profile extraction for channel sounding data, including path number, path delay, path power, AoA, AoD and etc
Notes
Memory allocation will probably fail when channel dimension larger than 16-by-16 is configured in the 32-bit SystemVue environment.
Therefore, 64-bit SystemVue is suggested with respect to hybrid beamforming workspaces

The W1906 5G library now includes the W1720 Phased Array Beamforming Kit, allowing deeper
support for phased array development, and applications of dynamic/custom beamforming.

W1917 WLAN library
Support WLAN 802.11ah format.
The examples for 11ah are located in Examples\Baseband Verification\WLAN\WLAN_11ah .
802.11ac Receiver measurements now support dynamic measurement tables, in a similar style to the 89600 VSA software

W1918 LTE-A library
Support DL 256QAM modulation
Support UL 256QAM modulation
Support MMSE-IRC as per RAN4 in LTE_A_DL_Rcv
Support Extended CP in LTE-Advanced source and receiver for both downlink and uplink
Support TM4 for both FDD and TDD mode
New NB-IoT source and receiver per Release 13
Support NB-IoT downlink source and receiver
Support NB-IoT uplink source and receiver
The new examples for NB-IoT are located in Examples\Baseband Verification\LTE_Advanced\NB_IoT
LTE UL and DL Receiver measurements now support dynamic measurement tables, in a similar style to the 89600 VSA software.

Obsolete Features
The S domain specification in rational form is obsoleted from SDomainSystem. Now it only supports S domain specification using poles and zeros.

Resolved Issues
MATLAB
The issue in using MATLAB R2015b and R2016a from MATLAB Script can be resolved by applying the MATLAB patch http://www.mathworks.

com/support/bugreports/1310916. MATLAB Script works with MATLAB R2014a, R2014b, R2015a, R2016b and after without the MATLAB
patch.

Licensing
The issue related to the vendor daemon agileesofd could sometimes crash while the License Manager and the Product Selector was running on a
remote Windows 8 machine has now been fixed with the newer FlexNET publisher 2015 (also known as version 11.13.1) that is automatically
installed by the SHORT_PRODUCT_NAME installer.

Known Issues
Licensing
Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best practice of the least-privilege security therein
results in the License Server related Windows Service to run with the LocalService Account privilege (instead of the LocalSystem privilege as
before.) Running with the LocalService Account privilege, an executable can no longer access any files located in the per-user specific type of
folders. As a result, any license file placed in those folders can no longer be accessed by the License Server when the License Server is
automatically started via the Windows Service upon each PC reboot. For the local node-locked license, this would not result in any disruption to
the usage of EEsof applications; however, for the license installed on a network PC that is accessed by multiple client PCs, this may cause EEsof
applications not to start after the network PC reboots
Workaround: Store your license files in the Windows folders that are accessible by the LocalService Account privilege. For example, C:
\ProgramData or C:\users\public are both qualified choices. In general, any folder that has the "Users" group listed in its Properties>Security
page and this "Users" group has the read permission enabled should work.
Starting from FlexNet Publisher 2015 (aka version 11.13.1), the default licensing timeout is set to 3 seconds (from the previous 0.1 second) to
better accommodate systems with high network latency. This could cause certain utilities in the License Manager to perform slower than before.
Workaround: Set the FlexNet licensing timeout to 0.2 seconds, via setting the environment variable FLEXLM_TIMEOUT=200000, to minimize
the performance degradation. However, if the network latency is already an issue in your environment, you may need to fine-tune this setting to
minimize the general performance degradation while still accommodating the network latency.
On a newly formatted Redhat 7 system, the EEsof Licensing tools may fail to boot This is because the FlexNet Publisher 2015 requires a certain
rpm
Workaround: Under the EEsof product installation directory, there exists a utility script named "Linux_sys_check.sh" under the bin directory. Run
this script to find out whether any rpm is missing; run this script with a "-y" command-line option to also have all the missing rpms
automatically installed if you have the sudo or root privilege.
The Linux FlexNet ID dongle driver installed with the EEsof licensing tools version 2016.05 may not be compatible with ADS 2016.01 or older
releases
Workaround: Use the older Linux dongle driver WkRt-Lin64-6.0.501-1.x86_64.rpm on the Redhat 5/6 systems instead, and only use the newer
dongle drivers on the Redhat 7 systems
License server may stop recognizing Flex-10 dongle on some systems within a few hours after starting
Workaround: If you experience this problem, install the latest WibuKey drivers from Wibu Systems.
Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine
Workaround: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.
There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating codewords in one license file can result in: a)
Remote simulations not working or b) A second local simulation not working in case the license is node-locked and also has incorrect version.
Workaround: It is strongly recommended that you do not mix node-locked codewords and floating codewords in one license file nor in any configu
ration that ends up with node-locked codewords and floating codewords both available on the same server. In other words, put the node-locked
license and the floating license on different servers, and point to the respective one based on what you need to run.
If a user simultaneously runs two instances of a product and has mixed different versions of the same codeword on one license server, extra
licenses may be pulled and result in unexpected “Licensed number of users already reached for this feature” errors.
Workaround: We recommend you remove expired codewords, to separate out the new and the old versions of codewords into different files and
different servers, and to point to the respective one based on what you need to run.
Not specifying the TCP/IP port for the license server during license setup may lead to unexpected behavior and/or license checkout failure on the
Windows platform. We strongly recommend you to always explicitly specify the TCP/IP port associated with each license server.
A node-locked and floating bundle operating on Linux cannot be shared between products using EDA License Tools version older than 2014.01
when run at the same time.
License Setup Wizard does not remove any previous user-configured FLEX Windows License Service manually set up by a user using FlexNet's
lmtools.
Workaround: You must remove the previous user-configured Windows License Service via lmtools.
Run the lmtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin to invoke the lmtools utility. The lmtools utility
window is displayed.

If you have installed an EEsof product released before 1st August, 2014 on your system prior to installing an EEsof product
released after 1st August, 2014 then the default EEsof Licensing tools path will remain C:\Program
Files\Agilent\EEsof_License_Tools. On the systems that only have EEsof products released after 1st August, 2014
installed then the default EEsof Licensing tools path will be C:\Program Files\Keysight\EEsof_License_Tools.

In the Service/License File tab, check the Configuration using Services option. All user-configured FLEX Windows License Services
will be listed.
Select the service you wish to remove.
Select the Config Services tab and click the Remove Service button to remove the service.
To ensure that the license service or lmgrd is running, click View Log. A log window appears that confirms whether agileesofd and lmg
rd are up and running.
While running multiple versions of prior SHORT_PRODUCT_NAME releases together,
set PRODUCT_NAME_MAXIMUM_BUNDLE_USAGE=ON in your environment so that all of them will use the same method to check out
licenses. Otherwise, you might receive an error message, "Licensed number of users already reached".
On some Windows 7 machines, when more than one definition of an Ethernet adapter exists (duplicates), license checkouts may appear to hang
up.
Workaround: Disable the duplicate network card definitions in your network settings: Control Panel > Network and Internet > Network
Connections. This issue has been acknowledged by Flexera and they have created a bug report (SIOC-000103097).
For LSF style distributed simulations, ensure that the PATH on the client computer points to the $HPEESOF_DIR/EEsof_License_Tools
/${architecture} directory that corresponds to the EEsof release being used. This needs to be done in order to ensure that the proper version of
the Flexera utilities (like lmutil ) gets picked up in the path before any older in-compatible versions (that may also be installed on a users’ system.)
License Setup Wizard ( aglmwizard.exe ), which is used to set up and record the license path would not work if you already have an environment
variable set for PRODUCT_NAME_LICENSE_FILE.
Workaround: You can use PRODUCT_NAME_LICENSE_FILE variable to point to license file or refer to Licensing (For Administrators).

The License Setup Wizard will exit or not properly configure a license server, if the server has all of its licenses currently in use.
Workaround: Wait for a license on the server to become available as you normally would before launching the product.
Unable to set license in case unicode characters are used either in path or license file name because the Flex License Service does not support
these characters.
The Product Selector tool will be unable to display the license server status properly when connected to older license server.
Workaround: Upgrade your license server to the latest version.

DPI Awareness
DPI awareness refers to the ability of the application to maintain reasonable window size on a high-resolution display. SystemVue is currently not DPIaware and uses automatic Windows scaling, known as DPI virtualization. In combination with certain Windows display settings this may result in
some visual artifacts, e.g. when resizing a docked pane, a phantom splitter image may appear, or toolbars may appear blurry.
Workaround: To turn off DPI virtualization, remove the line "WindowsArguments

= dpiawareness=0" from qt.conf located
in the bin directory under SystemVue installation (you may need administrative privileges to edit the file). The
workaround may cause uncomfortable SystemVue window size on a high-resolution display, so this is a trade-off
between tolerating the artifacts and maintaining a comfortable SystemVue window size.

Other Known Issues
SystemVue might encounter problems while trying to open any dialog box if the Dell Backup and Recovery Solution is installed.

Workaround: Unregister the shell extensions associated with the Dell Backup and Recovery Solution
should fix the problem. Execute the following commands from a command prompt:
regsvr32 /u "C:\Program Files (x86)\Dell Backup and Recovery\Components\Shell\DBROverlayIconBackuped.dll"
regsvr32 /u "C:\Program Files (x86)\Dell Backup and Recovery\Components\Shell\DBROverlayIconNotBackuped.dll"
regsvr32 /u "C:\Program Files (x86)\Dell Backup and Recovery\Components\Shell\DBRShellExtension.dll"

